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1 Overview 

The NoiseTools program is used to download measurement data from a range of Cirrus Research noise 
measurement instruments.  

Measurements are stored within a database with the file extension .crntd 

Audio recordings stored as individual files with the file extension .WAV 

The audio recordings are stored outside of the database and will typically be stored into separate folder. 

Note: NoiseTools 1.7.1 provides a new storage method for audio files with all recordings stored into a 
single .crntda file that is associated with the .crntd measurement database. 

This differs from the system used previously. See page 18 for details of the new audio system and how it 
can be implemented. 

 

A settings.xml configuration file contains the location of these files. 

For multiple-user installations, the location of the database and audio recordings should be consistent. 

The following sections contain information for advanced users and network administrators that may be 
useful when installing NoiseTools for multiple users. 

2 Essential requirements 

To ensure the smooth operation of NoiseTools, the following points should be reviewed and actioned 
where appropriate: 

1. All users must be running the same version of the NoiseTools program 

2. The name of the database being used should be changed from the default (data.crntd) 

3. Where roaming profiles are used, users are loading a consistent configuration 

a. They should be using the same database and users should have full read and write access 

to the location 

b. The location for the storage of audio should be the same and should be in a shared location 

that each users has full read and write access to 

4. Where possible, UNC paths should be used in preference over mapped drives 

5. Variables cannot be used in the paths for the database, audio files and trigger settings   
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3 NoiseTools System Requirements  

The NoiseTools software (supplied with the optimus sound level meters, doseBadge Noise Dosimeter, 
Trojan Noise Nuisance Recorder, CR:800C and CR:260A sound level meters) can be run on most modern 
PCs. To get the best from the software the PC should meet the minimum specifications below and where 
possible meet the recommended specifications. 

If you are using functions such as the FFT analysis or 3D playback of audio recordings, having a faster PC 
with a dedicated NVIDIA graphics card will be beneficial. 

Please note that NoiseTools is not compatible with the Apple Mac Operating system. 

Please note that as of February 2017, NoiseTools 1.7.1 does not support Windows XP or Windows Vista. 
NoiseTools 1.6.4 is still available for download for older systems. 

 

3.1 Operating System 

3.2 Minimum System Requirements 

• Windows 7 Service Pack 1 

• CPU: 2GHz Dual Core 

• Memory: 3GB 

• Storage: 10GB free space 

• Display: 1280x800 
 

3.3 Recommended System Specification 

• Windows 10 64Bit 

• CPU: 3GHz Dual Core 

• Memory: 4GB 

• Storage: 50GB free space 

• Display: 1280x1024 
 

3.4 Ideal System Specification 

• Windows 10 64bit 

• CPU: 3GHz Quad Core 

• Memory: 8GB 

• Storage: 100GB free space 

• Display: 2x 1920x1080 

• Dedicated NVIDIA graphics card with CUDA support 

• Dedicated sound card and external speakers 
 

3.5 Storage requirements for NoiseTools installation & measurement data 

• Approximately 1GB for installing NoiseTools and dependencies 

• Up to 512MB for temporary files during measurement download 

• 1GB per instrument per year for measurements and time history data, assuming typical usage 
 

Where an instrument is storing and downloading audio recordings, additional storage space will be 
required. The amount of storage will depend upon the length of recordings and the audio quality chosen. 
Audio recordings require the following amounts of space: 

Standard Quality  120MB/hr 

Studio Quality  1.4GB/hr 
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3.6 Sound card for audio playback 

NoiseTools can work with on-board sound cards and internal laptop speakers.  

However for best results a dedicated card and external speakers are required. 

Some on-board sound cards will not be capable of playing the studio quality 96kHz audio. In these cases an 
external sound card will be required that is capable of playing back this type of file. 

In some cases internal speakers are sufficient, however to playback at realistic levels, such as when using 
the speaker calibration feature, good quality external speakers are required. 

Audio files created by the Cirrus instruments and downloaded to the NoiseTools software are stored as 
WAV files. 

3.7 Graphics Card 

NoiseTools uses the latest technologies to draw the user interface directly using the graphics card. This 
gives a much better looking more responsive experience and allows us to easily provide certain advanced 
features, such as the 3D frequency analysis view. 

Most on-board graphics chips can provide more than enough power to display the basic user interface but 
the more advanced screens will be noticeably smoother on more powerful hardware. 

NoiseTools is also able to use the latest CUDA graphics cards, from NVIDIA, to do FFT and other complex 
calculations. This can be many times faster than running these calculations on the main processor.  

This feature requires a CUDA capable card and 64bit version of Windows. 

If a suitable graphics card is not detected, NoiseTools will display a message at the bottom of the main 
screen as shown below: 

 

NoiseTools will operate as normal without a CUDA capable graphics card. 
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3.8 Support for Windows XP & Windows Vista 

NoiseTools up to version 1.6.4 supports Microsoft Windows XP, Vista, 7, 8, 8.1 and 10 (see section 3.8.1 
below for details of Windows XP) 

NoiseTools 1.7 onwards will not support Windows XP or Windows Vista as these are not supported 
by .NET 4.6.2  

3.8.1 .NET 4.0 Framework 

All versions of the NoiseTools software use the Microsoft .NET Framework and this is installed as part of the 
Windows operating system. The version of the .NET Framework installed by depend upon the version of the 
Windows operating system that is installed. 

When NoiseTools was updated from v1.4.6 to v1.5, the .NET Framework used was changed from 3.5 to 4.0 
to allow for new functions and features to be added. 

By default, .NET 4.0 is not included with Windows XP (as this was released before .NET 4.0 was available) 
and so to run NoiseTools v1.5 or later on Windows XP, the .NET Framework 4.0 must be installed manually. 

Please note that Cirrus Research plc is not responsible for the loss of any data or any issues caused by the 
installation of the .NET 4.0 Framework. 

Users must ensure that their systems meet the minimum requirements before installation and all data 
should be backed up before installing this update. The requirements are given on the Microsoft website on 
the download page for .NET 4.0 

The .NET 4.0 installer is available from this link. 

Note that certain versions of Windows 7 may also not include the .NET 4.0 Framework and must be 
updated before they can run NoiseTools v1.5 or later. 

3.9 File Associations 

3.9.1 Required File Associations 

The following file associations are required for NoiseTools: 

.crntd 

.crntda 

.mtp 

.ntlink 

3.9.2 Additional File Associations 

.oafp 

Trigger(url) 

3.9.3 Windows Registry Keys 

See Appendix 1 for an example of the Windows Registry keys associated with NoiseTools.  
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4 Connectivity requirements 

4.1 USB Download of measurement data 

Most data is downloaded from the noise measurement instruments via a USB connection.  

The Optimus sound level meters present the internal data as a storage device within Windows. Users’ 
systems must be able to read from a connected USB storage device. 

Please note that the local system cannot write to the memory card as the instrument prevents this.  

The Optimus storage device cannot be encrypted by external services. 

Other instruments may require an additional drivers to be installed. This will be carried out when the 
device is connected to the local PC for the first time. 

The user’s system must be able to install drivers for connected devices.  

All drivers supplied by Cirrus Research plc are signed. 

4.2 Internet access for the NoiseTools program 

In order to function properly NoiseTools requires access to the following locations:  

• sms.crplc.co.uk 

• optimus-cloud.co.uk 

• s3.amazonaws.com 

NoiseTools only uses outgoing HTTP connections to port 80. 

4.2.1 sms.crplc.co.uk 

NoiseTools can determine if a newer version of the software is available. The program will connect to 
sms.crplc.co.uk (Port 80) and check is a new version is available. 

A notification will be displayed in the NoiseTools software.  

If the user has sufficient access rights to install programs, NoiseTools can download and automatically 
install updates. 

If sms.crplc.co.uk is not available, NoiseTools will continue to run as normal but will not be able to alert the 
user to new versions of the software. 

4.2.2 optimus-cloud.co.uk 

The Optimus Cloud service is used in conjunction with the CK:680 outdoor measurement kits.  

Access to the Optimus Cloud server is required to allow NoiseTools to configure email and twitter alerts 
and to store audio trigger templates. 

This is not required for the CR:15x (Optimus Yellow), CR:16x (Optimus Red) or Trojan Noise Nuisance 
Recorders. 

If optimus-cloud.co.uk is not available, NoiseTools will continue to run as normal 

4.2.3 Access to s3.amazonaws.com 

NoiseTools will backup and store instrument settings to a database on the amazon aws platform.  

This is not essential for software updates. No measurements, recordings or user data is stored. 

If s3.amazon.com is not available, NoiseTools will continue to run as normal 

4.3 Remote data access 

Please note that this functionality is only required when a CR:17x series (Optimus Green) is used with a 
CK:680 outdoor measurement kit. 
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This is not required for the CR:15x (Optimus Yellow), CR:16x (Optimus Red) or Trojan Noise Nuisance 
Recorders. 

When NoiseTools connects to a CK:680 outdoor kit using a remote connection, it requires access to the 
following: 

• dynamic.optimus-cloud.co.uk 

• The instrument IP Address 

 

You can find your instrument’s IP address via the Optimus Cloud website, once it has been linked to your 
account. Most instruments use a static IP address so this will not change over time. 

Note 1: Connections to the optimus/CK:680 instrument use an outgoing TCP connection to port 22850. 
These do not currently support forwarding through a proxy server. 

Note 2: These connections can be made from any available port in the range 49152 to 65535. The ports are 
allocated and controlled by Windows. 

Note 3: If the NoiseTools PC or network has a firewall that blocks outgoing connections, it will need to be 
configured to allow connections from NoiseTools to the Optimus/CK:680. 

This can be done by allowing any connection to the known IP and Port of the instrument(s). It can be 
further restricted to the IP address of the NoiseTools PC if required. 
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5 Installation 

Installation of NoiseTools is usually carried out from the DVD supplied with the measurement instrument. 

The latest version of the NoiseTools software can also be downloaded from the Cirrus Research website at 
www.cirrusresearch.co.uk/library/software 

If the software has sufficient access, it can download and install updates automatically. See section 4.2 for 
details of the connectivity required. 

 

5.1 First run configuration 

When NoiseTools is run for the first time, it will look to see if a configuration file exists in the current users’ 
roaming appdata folder (CSIDL_APPDATA).  

If a settings.xml file is found, this will loaded and the configuration used. The settings.xml file is not 
overwritten during an upgrade of NoiseTools. 

If the settings.xml file is not found, NoiseTools will create a default configuration file and will use the 
default file locations defined below. 

Where no record for a database is found, the program will create an empty database called data.crtnd 
and store it in the default location.  

The location for the database, audio recordings folder and trigger templates folder will be stored  into 
the settings.xml file. 

 

5.2 Default data storage locations 

The program will create a folder for audio records and trigger templates in the default locations.  

The default locations are: 

Measurement database:  \AppData\Roaming\Cirrus Research\NoiseTools 

Audio recordings: 

New Audio System in NoiseTools 1.7 (Single .crntda file)  

    \AppData\Roaming\Cirrus Research\NoiseTools 

Previous Audio System (Multiple .WAV files)  

   \AppData\Roaming\Cirrus Research\NoiseTools\audio 

Trigger templates:  \AppData\Roaming\Cirrus Research\NoiseTools\Trigger Templates 

 

If the settings.xml file contains different locations to the defaults, NoiseTools will use these instead. 

NoiseTools allows for data to be accessed from local drives, shared or mapped drives or network paths. 

UNC paths can be used where required. 

NoiseTools does not support the use of variables in the settings.xml file. 

Please note that if NoiseTools cannot to connect to the primary database, for example when a laptop is 
disconnected from the network, it will attempt to store the measurement data into the next available 
local database. 

If no local database exists, the measurement information cannot be stored and will not be downloaded. 

 

  

http://www.cirrusresearch.co.uk/library/software
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5.3 NoiseTools settings & configuration information 

NoiseTools stores the location of the measurement database(s), the audio files and the trigger templates 
within a configuration file called settings.xml.  

Additional information may also be stored in this file depending upon the type of instruments that have 
been connected to the software. This configuration file is stored in the current users roaming appdata 
folder (CSIDL_APPDATA). 

An example of a settings.xml file for a local user is shown below: 

<?xml version="1.0" encoding="utf-8"?> 

<goldfish xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

  <Databases> 

    <Database> 

      <Path>C:\Users\Bob Smith\Documents\NoiseTools\Test Data.crntd</Path> 

      <Enabled>true</Enabled> 

    </Database> 

  </Databases> 

  <AudioPath>C:\Users\Bob Smith\Documents\NoiseTools\audio\</AudioPath> 

  <TriggerPath>C:\Users\Bob Smith\Documents\NoiseTools\Trigger Templates\</TriggerPath> 

  <EnableCUDA_NEW>false</EnableCUDA_NEW> 

</goldfish> 

5.4 Using multiple measurement databases 

NoiseTools can use multiple databases to store data although only one can be active at any time. This 
allows measurement data to be organised more efficiently. For example, a new database may be created 
every year or for a different client. 

The Database Manager in NoiseTools allows the user to create new databases or to change the active 
database. The database that is at the top of the list in the Database Manager is active. 

To add, create or delete databases, use the Tools, Database Manager option from within NoiseTools. If the 
default database is not available, NoiseTools will use the next available database in the list. The example 
below shows 
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An example settings.xml file for multiple databases is shown below:  

<?xml version="1.0" encoding="utf-8"?> 

<goldfish xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

  <Databases> 

    <Database> 

      <Path>C:\Users\Bob Smith\Documents\NoiseTools\Test Data.crntd</Path> 

      <Enabled>true</Enabled> 

    </Database> 

    <Database> 

      <Path>C:\Users\Bob Smith\Documents\NoiseTools\Old Data.crntd</Path> 

      <Enabled>true</Enabled> 

    </Database> 

    <Database> 

      <Path>C:\Users\Bob Smith\Documents\NoiseTools\Customer Data.crntd</Path> 

      <Enabled>true</Enabled> 

    </Database> 

  </Databases> 

  <AudioPath>C:\Users\Bob Smith\Documents\NoiseTools\audio\</AudioPath> 

  <TriggerPath>C:\Users\Bob Smith\Documents\NoiseTools\Trigger Templates\</TriggerPath> 

  <EnableCUDA_NEW>false</EnableCUDA_NEW> 

</goldfish> 

 

5.5 Enabling & disabling databases 

Databases can enabled and disabled by editing the settings.xml file. 

Change the <Enabled> tag to false to disable a dataset and to true to enable a database: 

<?xml version="1.0" encoding="utf-8"?> 

<goldfish xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

  <Databases> 

    <Database> 

      <Path>C:\Users\Bob Smith\Documents\NoiseTools\Test Data.crntd</Path> 

      <Enabled>true</Enabled> 

    </Database> 

    <Database> 

      <Path>C:\Users\Bob Smith\Documents\NoiseTools\Old Data.crntd</Path> 

      <Enabled>false</Enabled> 

    </Database> 

  </Databases> 

  <AudioPath>C:\Users\Bob Smith\Documents\NoiseTools\audio\</AudioPath> 

  <TriggerPath>C:\Users\Bob Smith\Documents\NoiseTools\Trigger Templates\</TriggerPath> 

  <EnableCUDA_NEW>false</EnableCUDA_NEW> 

</goldfish> 
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5.6 Installation for multiple users 

Each user must be able to access the settings.xml file in their own roaming profile directory. If the user are 
going to share a database (or databases) and audio files, the location of these can be set in the settings.xml 
file which can then be pushed to each user after the initial installation of the main NoiseTools program. 

Installation of NoiseTools for multiple users requires that an instance is installed for the first user and the 
program run. This will allow a database to be created in the shared location and for a settings.xml file to be 
created. 

The settings.xml file can then be edited and deployed for each subsequent user as required. 

If may also be advisable to create a local fall back database that can be used if NoiseTools cannot access the 
default locations.  

Please note that if NoiseTools cannot access the location specified for the storage of audio recordings, 
these will not be downloaded. Users should be aware of the limitations of downloading data when the 
PC is not connected to a network. 

Section 6 covers importing data from an external source such as a laptop that is not connected to the 
main database. 

To install NoiseTools for multiple users: 

1. Create the folders in the shared location: 

a. Create a folder in shared location (network path, mapped drive etc) 

b. Create a sub-folder within this location for audio files 

c. Create a sub-folder within this location for trigger templates 

d. Ensure all users have read & write access to this folder & sub folders  

2. Install NoiseTools for the 1st user 

3. Run NoiseTools and configure the database and audio file locations using the Tools, Databases 
and Tools, Storage Manager, Audio options 

a. Tools, Databases 

b. Create New 

c. Create a new, empty database in the shared location in step 1a  

d. Move this to the top of the list of databases and ensure that it is highlighted as the 
active database 

e. Tools, Storage Manager, Audio Storage 

f. Change the location to the folder defined in step 1b 

4. Open the settings.xml file users roaming appdata folder & edit:  

a. Database location (defined in step 1a) 

b. Audio file location (defined in step 1b) 

c. Trigger template location (defined in step 1c) 

5. Run the NoiseTools program and verify that the program is using the locations  

6. Install NoiseTools for each subsequent user 

7. Copy the settings.xml file edited in step 6 into each users roaming appdata folder 
(CSIDL_APPDATA) 

8. Run the NoiseTools program and verify that the program is using the defined locations 
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5.7 Silent installation of NoiseTools 

NoiseTools can be deployed using a silent installation to allow it to be remotely installed over a network or 
through a management system. 

The NoiseTools installer supports a /S flag to enable silent install. 

Optionally you can also specify the installation path using the /D statement.  

For example: 

/D=C:\Program Files\Cirrus Research\NoiseTools\  

Please note that the installer requires Administrator access rights. 

 

5.8 Upgrading a NoiseTools installation 

Major updates for NoiseTools are released roughly every 6 months with minor incremental updates 
released more frequently. 

The incremental updates usually include minor changes such as additional language support, bug fixes or 
new reports. 

The major update usually include significant changes to either the interface, the addition of new 
functionality or support for new instruments. 

NoiseTools can be updated using either: 

1. Using the upgrade function that is built into NoiseTools 

Where connectivity allows, NoiseTools will communicate with the upgrade server to determine if a 
new version is available. NoiseTools will check the version number of the latest release which is 
provided from sms.crplc.co.uk through an HPPT connection on port 80. 

 If this connection is blocked, NoiseTools will not indicate when a new version is available. 

2. Downloading and installing the latest version from www.cirrusresearch.co.uk/library/software   
3. Requesting a DVD from Cirrus 

5.8.1 Upgrading from NoiseTools 1.4 or earlier to NoiseTools 1.5 or later 

The database schema used for NoiseTools 1.4 was changed when version 1.5 was released. 

This required that the database structure was upgraded to allow the new functions and features to be 
used. The upgrade process is carried out by the NoiseTools program when it detects a database from an 
older version (prior to v1.5). 

Before the conversion is carried out, a backup of the database is made and then the conversion is carried 
out. 

Once the database has been converted, it cannot be opened by previous versions of NoiseTools and so 
where multiple users are accessing a database, all installations of NoiseTools must be upgraded at the same 
time. 

5.8.2 Files modified during the upgrade 

NoiseTools will only modify the main program files and supporting files (reports etc) 

The following files are not modified during the upgrade process: 

• Database files 

• User Preferences 

• Configuration and settings files  

http://www.cirrusresearch.co.uk/library/software
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6 Transferring measurements between local and shared/networked locations 

It may be necessary to transfer measurements between NoiseTools installations that are not using the 
same database.  

For example it may be necessary to download measurements at a remote location or when playing back a 
measurement or recordings away from the office. 

In this instance, NoiseTools should be installed on to the laptop with the data storage locations setup as 
shown in example 6.1 for local use.  

Measurements can be exported from the main database using any PC that is connected to it and the 
resulting MTP file imported into the local database. 

Measurements can also be exported from the local PC to a main database using an MTP file which includes 
all of the measurement data and any associated audio recordings. 

MTP files can contain single measurements or multiple measurements. Note that MTP files can become 
very large if they contain multiple audio recordings. 

6.1 Exporting a single measurement 

To export a single measurement, open the measurement and click Tools, Export, Measurement Transfer 
Package. 

The Export window shows the measurements that are open. Ensure that the Export Options are checked to 
include all of the measurement data. 

Click Export and choose the location and filename for the MTP file. 

6.2 Exporting multiple measurements 

Multiple measurements can be exported by either; 

Opening all required measurements and using the export function above or 

Opening measurements as a group and using the Actions, Export button 

6.3 Exporting an entire database 

It is possible to export an entire measurement database and all audio recordings to a single MTP package. 
This may be useful to transfer data to a new PC or to create a single backup file. 

Click Tools, Transfer Measurements. 

Select Main Noise Tools Database as the source and MTP File as the Destination. Choose a filename and 
location for the MTP file. 

Click Next and use the options to select the measurement required. To choose all measurements use the 
Date option and select the Start Date as 01/01/1999. 

Click the search button to identify the measurements and click Select All. 

This function is available in NoiseTools version 1.5 or later. 

6.4 Importing an MTP file 

An MTP file can be imported by either; 

a. Double clicking on the file or 

b. Clicking Tool, Import, Measurement Transfer Package  

The data contained within the MTP will be imported into the currently active database and any audio 
recordings stored in the audio recordings folder.  
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7 Audio Storage in NoiseTools 1.7 

7.1 Previous audio storage system 

In previous versions of NoiseTools (1.6.4 and earlier) all audio data was stored in separate files within the 
shared audio folder.  

These recordings were stored as separate .WAV files. 

This has the advantage of being very fast and easy for NoiseTools to access whichever file is required. 
However, it uses a large amount of disk space and is very difficult to manage when backing up or moving 
databases. 

It is not recommended that the new file system is used where data is to be shared across a network, 
stored in a location remote from the application or where multiple users will be accessing the data. 

7.2 New audio system 

NoiseTools can now store all audio data inside a single compressed file. This can save up to 40% of the 
storage space and makes it much simpler to manage files. However, this can make loading lots of audio 
data slower than it would otherwise be because it takes time to decompress the data. This is especially true 
with long pieces of audio or those recorded in studio quality. 

The new system can also support storing audio uncompressed if maximum performance is required. 
However, this will of course use as much storage space as the old system. 

Another key aspect of the new storage system is that each database will have its own audio storage file 
which can be linked together.  

This is what makes it so much easier to manage backups or moving databases. Previously you would have 
to move the database file and some, or all, of the audio files in the shared audio folder.  

Now you can simply move the database file and the associated combined audio file (.crnta). 

 

7.3 Converting your audio data 

This first time you start NoiseTools after upgrading to 1.7 you will see the welcome screen reminding you 
where your data is stored. This will also contain a note telling you to use the Storage Manager to convert 
your audio data. 

It is not recommended that the new file system is used where data is to be shared across a network, 
stored in a location remote from the application or where multiple users will be accessing the data. 

You will also see an item in the common tasks list whenever you open a database that is still using the 
shared audio folder. You can click on this item to take you directly to the Storage Manager. 

Below are instructions for converting your data to the new format: 

1. Open NoiseTools. 
2. Click on the Tools menu and choose Storage Manager. 

You should make a note of the location of the shared audio folder for use later. 

3. Click the Convert button. 
4. A new window will appear allowing you to choose various settings. 
a. Linked to Database, is the recommended option. 

This will keep your audio in a file with the same name and location as your current database. If you ever 
move or rename the database, the audio will be moved as well. 

b. Other Folder, allows you to choose a specific location for the audio file. 
c. Enable Compression, will compress the file to save space. This is recommended. 
5. Click OK to start the conversion. 
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6. You should see a progress bar on screen. 

It can take some time to copy and compress all of the relevant audio files. 

7. Once complete the progress bar will disappear. 
8. This database is now using the new system to store data. You should repeat the above process for 
any other databases you have. 
 

7.4 Changing and moving audio files 

Once you have converted to the new storage system it is much easier to move or change these files. 

These instructions show how to change the audio storage location for the current database. 

1. Open NoiseTools. 
2. Click on the Tools menu and choose Storage Manager. 
3. Click the Change button. 

If your audio file is currently stored alongside the database, you will get a warning about separating them. If 
you do want to continue click OK, if not, see the instructions below for moving databases. 

4. Choose the new location and click save. 
5. The file will now be moved. This may take some time. 

If your audio file is linked to a database, and you want to keep it together, you can use these instructions to 
move or rename it. 

1. Open NoiseTools. 
2. Click on the Tools menu and choose Databases. 
3. Select the database you want to move. 
4. Click the Move/Rename button. 
5. Choose the new location and click save. 
6. The database file and audio file will now be moved. This may take some time. 

The databases screen shows all of your databases as well as where the audio is stored for each one. If the 
audio file is linked to the database, it can be moved from this screen as above. To convert any that are 
listed as Shared Folder or to move any separate audio files use the Storage Manager. 

 

7.5 Clearing the shared audio folder 

Once you have converted all of your databases to use the new audio storage system you may find there are 
some files left in the shared folder. This can happen if you have deleted a database as the audio files may 
not have been removed. It may also happen when measurements are deleted or if there was a problem 
while downloading from an instrument. 

If you are satisfied that all of your databases have been converted correctly and the audio has been moved 
to the new storage files, you can simply delete all of the old files from this folder. 

Instructions: 

1. Open File Explorer and navigate to the shared audio folder. 

By default, this will be ‘C:\Users\<USERNAME>\AppData\Roaming\Cirrus Research\NoiseTools\Audio\’ 

If you have changed this location, you need to make a note of it during the conversion. 

2. Press Ctrl+A or click the Select all button in the top right. 
3. Press Shift+Delete or click the arrow below the Delete button and choose Permenantly delete. 

If you choose to send these files to the recycle bin instead, remember to empty it as they could be using a 
lot of disk space. 
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4. Click Yes on the confirmation dialog. 
 

7.6 Notes 

7.6.1 Compression 

Audio data is stored using a form of Lossless Compression, similar to a zip file you might use to store 
documents. It does not use MP3 or other forms of Lossy Compression. This means all your data is preserved 
exactly as it was recorded. 

7.6.2 Continuing to use the old system 

You can continue to use the old audio storage system if you wish. However, you will not benefit from the 
new features such as compression and improved file management. It is recommended to convert your data 
as soon as is convenient. 

NoiseTools 1.7 will continue to fully support the old format however future releases may remove that 
functionality. 
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8 Example installations 

8.1 NoiseTools installed onto a single PC with all data stored locally 

 

 

 

8.2 NoiseTools installed onto 2 PC’s with data stored on a shared drive 

 

 

 

8.3 NoiseTools installed onto multiple PC’s with data stored onto a network location 
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9 Troubleshooting NoiseTools installations 

9.1 Audio recordings are not available and show as grey markers 

Cause 

1. The audio recordings have been downloaded to a location that is either not shared or is no longer 
available.  

The location specified for the database is shared but the location specified for the audio recordings 
is defined as a local path. 

Users will be able to load audio recordings that they have downloaded themselves as these are 
stored on their local PC. Other users will be able to open the database and view measurements but 
will not be able to play and listed to audio recordings downloaded by other users. 

Resolution 

1. The location of the audio recordings is stored as a relative path within the NoiseTools database. 
NoiseTools uses the file path specified in the settings.xml file to locate the folder containing the 
recordings. 

For each user, check the location of the audio storage using Tools, Storage Manager, Audio Storage.  

If the path is local, change this to be the shared folder defined for audio recordings. NoiseTools will 
move any audio recordings to the new location. 

Note that this may take some time depending upon the number of audio recordings that have been 
downloaded and stored. 

When the audio recordings have been moved, close and re-open NoiseTools and confirm that the 
location of the audio recordings has been changed. 

 

9.2 NoiseTools crashes on startup or hangs at the boot screen 

Cause 

1. The locations specified for the database and/or audio recordings cannot be reached 

2. The paths may be specified as mapped drives and the mapping may have changed 

Resolution 

1. Ensure that the locations specified in the settings.xml file are available. View the settings.xml 
file in the users roaming profile folder to ensure that the specified locations and files are still 
available 

2. Specify the paths as UNC rather than mapped drives. If the user is using a laptop that can be 
disconnected from the network, ensure that mapped network drives are still available and that 
drive mapping has not changed 

 

9.3 Measurement download is slow 

Cause 

1. The measurement database is very large and the amount of physical memory on the PC is low 

NoiseTools requires sufficient memory to download and store measurements. If the amount of 
memory available it limited, the data will need to be swapped between the storage location 
and memory which can slow the system. 

2. The storage drive is full or nearly full. 

3. Access to the storage location is slow due to network traffic.  
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4. The measurement database and/or audio recordings are stored using a file sharing system such 
as DropBox 

Resolution 

1. Refer to the minimum system requirements in section 3.2 

2. Check the available space on the specific storage system  

3. Review network traffic.  
If the database is stored on a networked drive or storage location, ensure that there is no  

4. File sharing systems such as DropBox work by detecting changes to a file and transmitting these 
changes to the Dropbox folder in the cloud where other computers can access these changes.  

Each time a file is modified, the Dropbox program lock the file, send the modified file to the 
server and then unlock the file again at which point it can be used by the program on your PC.  

Depending upon the speed of the connection between the PC and the Dropbox server and the size 
of the file, this can be almost instant. 

However, a NoiseTools database is one single file that can be quite large.   

Even if a very small part of the database is changed, for example a marker is added to one 
measurement, the entire database file must be locked and then transferred to the Dropbox server 
before it can be unlocked and made available to NoiseTools. 

This can create some significant issues for NoiseTools, especially when downloading 
measurements.  

Each time a block of data is stored into the database, the whole database file will need to be 
synchronised back to the Dropbox server before the file is unlocked and is made ready to 
NoiseTools to store the next block. 

The larger the database, the larger these overheads will be and this can significantly slow down 
NoiseTools.  This can also be affected by the speed of the connection from the PC to the internet 
and then onto the Dropbox server. The local file will not be unlocked until the synchronisation is 
complete. 

The Dropbox model breaks down very quickly if multiple computers are accessing the same file at 
the same time as Dropbox wasn't meant to replace a networked database server.  

This can happen very easily because as long as NoiseTools is running, it has the database file open.   

If Dropbox makes changes to the database file while NoiseTools has it open (for example if the 
database is access on another PC), there is no way for NoiseTools to know about the changes made 
by Dropbox.  

 

9.4 NoiseTools is slow to startup and shows a blue circle 

Cause 

1. NoiseTools reopens the last used measurements. If the program is closed with measurements still 
open, these will be opened when the program is next started. 

Resolution 

1. Close the measurements before closing NoiseTools. 
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9.5 The measurement database cannot be found 

1. The locations specified for the database and/or audio recordings cannot be reached  

2. The paths may be specified as mapped drives and the mapping may have changed  

Resolution 

1. Ensure that the locations specified in the settings.xml file are available. View the settings.xml 
file in the users roaming profile folder to ensure that the specified locations and files are still 
available 

2. Specify the paths as UNC rather than mapped drives. If the user is using a laptop that can be 
disconnected from the network, ensure that mapped network drives are still available and that 
drive mapping has not changed 

 

9.6 The database is empty each time that NoiseTools is opened 

Cause 

1. The specified database cannot be found and NoiseTools is using a blank, default database each 
time the program loads 

2. A user is moving or exporting measurement data from the database  

3. The user has changed the default database using the Tools, Databases options  

4. The settings.xml file is being automatically rolled back to a previous state by an external system 

Resolution 

1. Check the databases that are specified in the user’s settings.xml file that is loaded when 
NoiseTools starts. If the first database that is listed is not available, NoiseTools will use the next 
available database. 

This may be an empty database (often called data.crtnd) and may be stored locally.  

Reset the initial database. 

2. Ensure that users are not deleting measurements from a shared database.  

3. Inform the user as to the importance of not changing databases without switching back to the 
master database. 

4. Prevent the settings.xml file from being restored from a previous state  

 

9.7 Measurements cannot be found 

Cause 

1. Measurements have been downloaded into a different database from that which is open  or 
that is opened as default 

2. The user has manually changed the current database  

Resolution  

3. Change the database that is currently open 

4. Change the database that is currently open 
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9.8 Changes in instrument configuration cannot be written to the sound level meter 

Cause 

1. The sound level meter appears as a mass storage device within Windows and NoiseTools must be 
able to read and write to an attached mass storage device without any restrictions. 

A local firewall or AV software may be preventing free read and write access to the mass storage 
device.  

2. Local disk encryption software may be attempting to encrypt any attached mass storage device. 

The mass storage presented by the sound level meter is fake. Between the storage in the sound 
level meter and the PC is the processor unit of the instrument. All commands send to and from the 
memory card are parsed by the internal software of the instrument. 

There is no direct read access to the internal memory card other than by the internal software of 
the sound level meter. 

Resolution 

1. Ensure that any local firewall or anti-virus software is not blocking access to the sound level meter. 
2. Modify any local disk encryption software so that it is not attempting to encrypt the memory of the 

sound level meter. 
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10 Appendix 1 Registry Keys 

Below is an export of the Windows Registry keys for NoiseTools which describes the file associations and 
actions stored for a NoiseTools installation. 

 

Windows Registry Editor Version 5.00 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Import] 

"FriendlyTypeName"="@shell.dll,-8975" 

"CurVer"="CirrusResearch.NoiseTools.Import" 

"AppUserModelID"="CirrusResearch.NoiseTools.Import" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Import\DefaultIcon] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\images\\mtp.ico" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Import\shell] 

@="Open" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Import\shell\Open] 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Import\shell\Open\Command] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\NoiseTools.exe /import %1" 

 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Link] 

"FriendlyTypeName"="@shell.dll,-8975" 

"CurVer"="CirrusResearch.NoiseTools.Link" 

"AppUserModelID"="CirrusResearch.NoiseTools.Link" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Link\DefaultIcon] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\images\\ntlink.ico" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Link\shell] 

@="Open" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Link\shell\Open] 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Link\shell\Open\Command] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\NoiseTools.exe /link %1" 

 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Open] 

"FriendlyTypeName"="@shell.dll,-8975" 

"CurVer"="CirrusResearch.NoiseTools.Open" 

"AppUserModelID"="CirrusResearch.NoiseTools.Open" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Open\DefaultIcon] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\images\\crntd.ico" 
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[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Open\shell] 

@="Open" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Open\shell\Open] 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Open\shell\Open\Command] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\NoiseTools.exe /open %1" 

 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Trigger] 

"FriendlyTypeName"="@shell.dll,-8975" 

"CurVer"="CirrusResearch.NoiseTools.Trigger" 

"AppUserModelID"="CirrusResearch.NoiseTools.Trigger" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Trigger\DefaultIcon] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\images\\oafp.ico" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Trigger\shell] 

@="Open" 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Trigger\shell\Open] 

 

[HKEY_CLASSES_ROOT\CirrusResearch.NoiseTools.Trigger\shell\Open\Command] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\NoiseTools.exe /trigger %1" 

 

 

[HKEY_CLASSES_ROOT\trigger] 

@="URL:trigger Protocol" 

"URL Protocol"="" 

 

[HKEY_CLASSES_ROOT\trigger\DefaultIcon] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\images\\oafp.ico" 

 

[HKEY_CLASSES_ROOT\trigger\shell] 

@="open" 

 

[HKEY_CLASSES_ROOT\trigger\shell\open] 

 

[HKEY_CLASSES_ROOT\trigger\shell\open\command] 

@="C:\\Program Files (x86)\\Cirrus Research\\NoiseTools\\NoiseTools.exe /trigger %1" 

 

 

[HKEY_CLASSES_ROOT\.crntd] 

 

[HKEY_CLASSES_ROOT\.crntd\OpenWithProgIds] 

"CirrusResearch.NoiseTools.Open"="" 
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[HKEY_CLASSES_ROOT\.ntlink] 

 

[HKEY_CLASSES_ROOT\.ntlink\OpenWithProgIds] 

"CirrusResearch.NoiseTools.Link"="" 

 

 

[HKEY_CLASSES_ROOT\.mtp] 

 

[HKEY_CLASSES_ROOT\.mtp\OpenWithProgIds] 

"CirrusResearch.NoiseTools.Import"="" 

 

 

[HKEY_CLASSES_ROOT\.oafp] 

 

[HKEY_CLASSES_ROOT\.oafp\OpenWithProgIds] 

"CirrusResearch.NoiseTools.Trigger"="" 


